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Painting With Light Workbook July 2006 

TECHNICAL 
This handbook contains technical information relating to the current settings that we use. These change, and 
rather quickly. They also may vary according to your own equipment and requirements, and the effects and type 
of video you work with. 

Unfortunately, there are some unavoidably geek issues we have to cover. Muddling our way through all this stuff 
when we were starting out was frustrating, and it took a lot of online research to even establish the basics. The 
online VJ community is VERY helpful, but it would have been so much easier if we could have just got a 
handbook that covered the basics. So you don©t have to go through all that, we©ve made you one :) 

Choosing your format  
We use .avi mostly, although mov is also acceptable, as are a variety of other formats. Resolume will play a lot 
of formats, but may error or not recognise codecs (see below). We find that avi, mov and swf work most reliably. 

What size to make one's clips?  
This really depends on how much content you©ve got, how powerful your computer is etc. Most VJs these days 
seem to be using 640x480, although a lot of the higher-end VJs turn their noses up at anything less than 
broadcast quality (PAL or NTSC). As we have a HUGE number of clips (over 15,000 at last count) that just isn©t 
realistic for us. Hard Drives are coming down in price, but there©s only so many you can logistically manage at 
once. 

We use a codec that upsizes well, so we find that for live gigs, 400x300 is just fine and that©s the resolution most 
of our video is at. We resize it up to 800x600 in Resolume and that©s the resolution we project at. As 400x300 is 
a multiple of 800x600, it scales up easier than 384x288, the resolution we initially started VJing with. 

When we©re recording for release on DVD, we work at higher resolution (full PAL), re-ripping what we need from 
our Master Sources (usually mini-DV tape) and clogging up a Hard Drive for just long enough to make the video 
clip, then deleting it all again or saving it onto data DVDs (be aware that DVDs are far less archival than CDs at 
this stage though). We always keep our Master Tapes for anything we might possibly want to re-use. 

The current version of Resolume works best if you use clips that are the same size, and set your Output settings 
accordingly. So, for example, if you have a bunch of free VJ loops you wish to use, you will need to resize them 
to the same settings of the clips you make yourself. Resolume can use differently-sized source clips, but your 
results will be pretty patchy - for example, clips may appear jagged or blurry. 

Because even batch-converting clips is time consuming, and also because you can©t upsize clips without losing 
quality, you really need to decide on what size you©re intending to work with and then stick with that. Moving up a 
size involves returning to your sources and re-harvesting, which is a huge and somewhat depressing task once 
you have a large library of clips. If I was starting out now, I©d go for 640x480 or PAL resolution (720x576) as long 
I had a computer that could cope in Resolume with multiple layers of such large video with effects. 

Why not widescreen? We, like most VJs, work 4:3 as that makes the most of the possible projected area with 
the majority of projectors. If you know you’ll always be working, say, with a 16:9 projector and you want to VJ at 
that format, then you could commit to that and make your clips an appropriate size/proportion. Obviously having 
some clips in each format can be problematic, unless that’s the look you’re aiming for in your layering. When we 
want a widescreen-look, we still use our 4:3 clips, but we push digitally in Resolume, or use a simple jpeg mask 
to cover up some of the image. For example, our Views From A Moving Vehicle I is about 3:1 format – but it 
was made using our normal 4:3 clips, with a Vertical Collapse in Resolume. 

Which Codec to use? 
A video codec ©Compressor-Decompressor© or ©Coder-Decoder© is used to reduce the filesize and increase the 
playability of a video file. Uncompressed video footage is enormous, and also very difficult to play - even with a 
very fast CPU and a few Gig of RAM. Different Codecs are better for different applications. 

For VJing, you need a codec that resizes well, runs smoothly (low CPU demand) and maintains good quality. 
Our preferred codec for our VJ clips is Ligos Indeo. We use the latest (commercial) version of this codec as it 
resizes footage well, and does a really good job of compressing footage while maintaining quality. Unfortunately, 
it only works on Windows XP and the latest version costs money (US$15). An old version 5.1 was free, and is 
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still available from www.free-codecs.com Our choice of codec does, however, mean that it©s difficult for us to 
share clips as they will only be of use to another VJ running Windows XP, and who has  the Indeo codec 
installed. Other popular VJ Codecs include PicVid©s MJPEG (costs US$99) and MidVid (free). 

For serving on the web, you need a codec that©s widely compatible, that reduces the size substantially without 
creating too many artefacts. CPU demand isn©t such an issue, although ability to play streamed may be. The 
simplest way to export that seems to be widely compatible is to specify mpeg1 format for VCD. 

For video iPods you need to use .mp4 format, which uses the h264 codec. Quicktime Pro is the easiest way to 
do these conversions, and it©s not terribly expensive. It©s also useful to convert your video to work on a mobile 
phone, although a huge variety of requirements currently exist among mobile handsets. 

SleepyTom.co.uk has a chart comparing several common video codecs - including the horrendously outdated 
Cinepak that some people persist in using as it©s the only one they know, even though it creates huge chunky 
compression artefacts and serious colour-bleed. 

How many Keyframes? 
A keyframe is a frame that contains all information relating to a frame, as opposed to tween frames that are 
smaller and rely on information from previous frames.  

When you're making clips for VJing, as you want to be able to scrub the video back and forth etc, you need to 
set a keyframe every frame when rendering your video. ie, Keyframe every 1 frame 

When you©re exporting your videos for serving on the web or video iPods, though, you can keyframe far less 
often - this will reduce the size of the video substantially. 

Other technical blah 
There are many other issues regarding settings for video. The screenshots here show the settings we currently 
use, but you may have to alter some of them depending on the specifications of your computer, for example. 
Unfortunately, there are no settings that we can tell you to use that will be the best for you, and that won©t 
change. We©ve shown our current settings merely as a guide. 
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ETHICAL 

Is it legal to use clips cut from movies, TV, downloaded from the web? 
Copyright law varies greatly between countries. For example, in the US the principle of “Fair Use” is established 
in law. We have no similar provision in Australia. In the US, Copyright needs to be registered with the Library of 
Congress to be valid, whereas in the UK, Australia and many other countries, it©s a inherent entitlement simply 
by the creation of a creative work, and lasts until a period of time (50-100 years) after creation of the works or 
death of the artist (depending on the medium, when it was created etc). 

Just to confuse the issue, often companies CLAIM copyright, for example on a website or DVD, when in fact the 
content itself is Public Domain (copyright-free) and only minor things that you wouldn©t want to use, such as the 
DVD©s interface, are actually the copyright of the company. 

As you can imagine, it©s therefore often very difficult to establish if something is copyright-free. 

The easiest way to avoid trouble is to make all your content yourself. If you©re interested in using pop cultural 
themes though, it©s quite likely that you©ll want to use ©harvested© content. Be aware of the issues and context in 
which you©re using the material, and avoid companies who are known to be litigious. 

So where CAN I get legal content? 
You can harvest from known Public Domain sources - there are many such resources, eg at archive.org - there 
are currently over 600 vintage feature-length films available there for free download. 

There are also generous souls who give away free VJ loops, or you can buy downloads or DVDs of  prepared 
VJ loops specifically for use in your VJ performances. 

If you want to harvest contemporary content, for example from TV or movies, I©d suggest you be aware of the 
issues and be respectful of other people©s rights. How would you feel if someone got hold of your work, for 
example, and used it without paying or crediting you? 

How can I protect my own material? 
As soon as you put anything out there in the public arena, it can be copied. Copyright protection mechanisms 
are all able to be broken in some way, and they©re expensive.  

As someone who©s had my work commercially pirated in the past, it actually did my career a fair bit of good, 
contributing to my getting a major publishing deal thought proving demand for the work. 

Having said that, if you want to show your work and don©t want other VJ©s using it and maybe passing it off as 
their own, then I©d suggest branding your video. This way, the more it gets shared around the web, the more it 
well help your profile (well, assuming it©s any good!). 

Is it legal to film anything I like in a public place, and to use the content in 
my work? 
This is another issue that varies between countries. Artistic works, for example public art, musical and dance 
performances, are generally protected under copyright law - so best to avoid filming them, or get them to sign a 
Release.  

In Australia, it©s currently legal to film people in public places without their consent, but not to record their voice 
(as that©s covered by Telecommunications legislation). There have been cases, for example of concealed-
camera up-skirt websites and creeps filming little kids on beaches that have shown just how lax our laws are 
here in that regard. I©d suggest that again, you use respect. Especially if you don©t want someone smashing your 
camera in your face. 
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SHOOTING TIPS 
Some of you here are already film-makers, and no doubt far more skilled than us in shooting video. You might 
find though that what works best for video-painting could be quite different to what you©d normally shoot. 

Depending on the effects you use, colour, contrast and movement can be very important in the look of your 
video paintings.  

Since you won©t be sure of your preferred style until you©ve been playing with the tools for many weeks, we 
suggest that you get a range of footage in your very brief shooting session today. We©ll also provide you with 
demo clips to work with, but our main concern is to ensure that you can create your own content from scratch. 

There may be some camera-specific tricks you might like. We love the low-lux setting, which is on most modern 
video cameras in some form and creates beautiful blurry trails at night. One of our old Analogue video cameras 
did the most beautiful feedback when pointed at a monitor. Sometimes seriously cruddy old equipment might 
produce interesting and creative effects. You can be a lot more experimental with this medium, so try to leave 
behind all the rules they taught you at Film School ;) 

For background layers, we use a lot of abstract footage, for example shot in extreme close-up - textures, light-
trails and such. We then use these conjunction with more figurative, identifiable clips. 

VJ TIPS 
Watch the work of as many VJs as you can possibly get your hands on. This is a very young Industry still finding 
it©s feet, but like the days of early cinema, it©s a very exciting and experimental time. There are very few rules yet 
- it©s all just evolving, and much of this is being led by just what©s possible as the software and effects filters are 
developed. 

You can use a huge variety of material in VJing, including still images, animation, scanned objects - basically 
anything that can be digitised into a format compatible with your VJ software. We©ll only be using video during 
the workshop, but that©s just because we have such limited time. 

Find musicians you enjoy working with. Creative partnerships between VJs and musicians can be very beneficial 
to both parties. There are a lot more musicians wanting visuals at this stage than there are good visuals people, 
so once your skills are developed sufficiently it shouldn©t be too difficult for you to find musicians to work with. 
Find an unsigned band on MySpace whose music you like, and offer to do some visuals to one of their tracks. 
Most acts will be very pleased – and you can both use the results to promote yourselves.. 

While playing with Resolume, you might notice that there are a lot of cheesy effects that tend to show VJing©s 
background as eye candy for tripping club bunnies around the turn of the Millennium. Happily, many VJs have 
moved on from there and corny effects like Tunnel, Kaleidoscope and obvious, pulsing audio-synced effects are 
sort of taboo in the VJ Community these days, unless you©re trying to be retro or kitsch.  

However, some people still think a VJ©s video has to be beat-synced to the music. Unfortunately many of them 
manage Nightclubs. The VJ Community tends to call that “Winamp VJing” after one of the first music visualisers 
for PC, developed in the late 90©s. As the average person has now been (over)exposed to music visualisers such 
as iTunes and Windows Media Player, VJs have moved on to more sophisticated and subtle effects. I know, I 
sound like a right snob here, but... not the ArKaos Tunnel, oh noooo..... 

Aside from Resolume, the software we’ll be demonstrating with during this workshop, there are free trials of a 
variety of other VJ Programs available. It might be worth you trying all of them one after the other as your trials 
run out, so that when you commit to which one/s you want to buy, you’ll be doing so confident of why you’ve 
chosen that particular software. Some others to download: 

Motion Dive - Mac or PC VJ software. Great for hardware integration, funky interface 

Arkaos - Mac or PC VJ software. Good for integration with lightshows etc. 

Livid Union - Mac or PC VJ software. Good for AV scratching. 

AVmixer Pro - Really straightforward Mac or PC VJ software. This site also has AVdrum, a freeware AV 
Sequencer that©s Mac or PC. 

Grid Pro – Mac VJ Software. Works with Freeframes. 
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VJ EQUIPMENT 
There are probably almost as many VJ Rig setups as there are VJs.  

Software-based VJs rely mostly on a computer with VJing software to apply effects to clips and/or a direct 
camera stream.  

Hardware-based VJs rely mostly on specialised VJ-equipment such as video mixers (aka vision mixers), DVD-
J©s (that you can scratch DVDs with, like a DJ©s CD-J), DVD Players, Kaoss Entrancer Scratch Pads and an 
ever-increasing number of new equipment. 

The most basic possible set-up for a Software and Hardware-based VJ respectively, with a live camera feed: 

Note that with many pieces of VJ hardware, you need an output monitor to see your controls on screen. It can 
also be handy if you don©t have a good sight-line to your projector output as unlike a laptop, there©s no inbuilt 
screen to show you what you©re doing. 

There are advantages and disadvantages of each emphasis, so more commonly VJs use a combination of 
Software and Hardware. Here©s a more typical example of a combination VJ Rig: 
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If you©re interested in our personal Setup, this is a fairly typical example of what we©d take to a Gig. Our usual 
Studio Setup at home is a little different, and you can check it out on our website. You can also see a lot more 
about our particular pieces of equipment there as well. 

 

We©re often asked what are the minimum and optimum specs for a VJ computer.  

Minimum Specs for Resolume (our main VJ software) are: 

·  1024x768 screen resolution  
·  1 Ghz processor  
·  256 Mb RAM  
·  Windows XP  

Although we©d suggest more RAM is really needed, especially if you©re interested in working with live camera or 
multiple layers of video, and applying multiple real-time effects. The more RAM, the more effects you can apply 
and the less lag you©ll have. Our lappies currently have 2Gig of RAM. 

We prefer the portability and convenience of laptops, but if you can be bothered lugging a tower around, or if 
you©re VJing at home, then a box is fine - you can fit more RAM and Hard-drives, and it will be much cheaper for 
equivalent specifications. 

Whether it©s a laptop or a desktop PC though, choose one with a proper, dedicated video/graphics card (not 
“integrated© or “shared” graphics). At least 64 meg of Video RAM is probably a good idea. Ours are 128meg 
Radeon cards. You also need at least video-in, or preferably video-in and video-out. 

If you©re considering other VJ equipment, there©s a huge range of hardware reviews at VJCentral.com, even 
including for vintage video equipment. 

If you©re after a cheap video desk for starting out, you might be able to get something adequate overseas on 
eBay. Germany and the UK are good places to look, as they©re PAL and 240volt power (like Australia). Shipping 
will cost a fair bit, but we still found it cheaper than buying in Australia as even old video-desk here (in fact, any 
remotely VJ-related equipment - such as midi trigger devices) goes for a lot more here than you can buy the 
same item for overseas.  

If you©re buying new, you©re probably better off buying in Australia for warranty purposes. Look up a price online 
and then try to beat the suppliers down to somewhere near that price. Bluff may even work :)
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HANDS ON 

Installing the Essentials 
Firstly, copy the following software onto your PC from the CD supplied. We keep an Incoming folder for this sort 
of thing. 

�� Panasonic DV AVI Type2 Codec 

�� The K-Lite Mega Codec Pack - includes the Indeo 5.1 Codec 

�� Exsate DV Capture 

�� Virtual Dub 1.6.15 (the specific version is important – don’t just use latest) 

�� Resolume 2.3 Trial and and Freeframes  

Now we’ll install the programs. 

Installing the Codecs 
The file format you will be using to rip your footage from your video camera is DV AVI Type 2 - which is what we 
need the Panasonic Codec for. Type 2 is the newer DV AVI format and includes separate compression for audio 
and a few other improvements. 

To install Panasonic DV AVI Type2 Codec: 

1. Right click on panadv.inf  

2. Click install. A Windows warning will come up - hit Continue Anyway.  

You will now be able to open Type 2 DV files captured with Exsate DV in Virtual Dub. 

Note: There may be complaints if you have a newer version of the Panasonic DV AVI codec on your computer 
(for example, if you own a Panasonic video camera and have previously installed the necessary software on 
your PC. If so, don’t worry – you didn’t need the old version anyway! 

 
 

 

To install K-Lite Mega Codec Pack: 

1. Double-click on klmcodec153.exe. 

2. Follow the instructions. 

This pack includes Indeo 5.1. 

Note: Again, you may run into complaints from Windows if you already have newer versions of any of the codecs 
already installed. And again, this shouldn’t be a problem – it just shows you didn’t need that older codec. 



10 Copyright Kat Black + Jasper Cook, 2006. � � � � � � � � � �

Installing Exsate DV Capture 
This is incredibly straightforward, so I feel like a patronising git having it here, but we did say non-geeks could do 
the course, so perhaps someone will find it useful ;). Just follow the screenshots. 

    

    

Installing Virtual Dub 1.6.15 
You don©t actually install Virtual Dub – you copy it. 

1. Copy the whole Virtual Dub 1.6.15 folder to somewhere you will find it again (eg in your Programs 
Folder). I’ll assume you know how to Copy a file. 

To open Virtual Dub, you could just find the folder and double-click on the VirtualDub.exe file. 
Admittedly, that©s a bit of a pain to find each time. It©s a lot easier to make a Shortcut on your Desktop. If 
you don©t know how to do that, it©s a handy thing to be able to do. Here©s one way (there are many). 

2. To make a Desktop Shortcut: Right-click on the VirtualDub.exe file and click Make Shortcut. Now drag 
that to your Desktop. Click slowly in the name on your Desktop and rename it something obvious. 
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Installing Resolume 2.3 
Installing Resolume is very straightforward, just double-click the installer: resolume-2-3-installer.exe. 

     
Resolume was developed by two Dutch VJs and is the preferred software of a number of the world©s top VJs. 
While the interface isn©t terribly glamorous, it©s very practical and powerful software. They put a considerable 
effort into the continuous development of Resolume, as well as contributing to the VJ Community with Freeframe 
effects and the like. There is nothing remotely similar available as Freeware, and the approx US$250 for a 
licence goes directly to the developers Edwin de Koning and Bart van der Ploeg - so please don©t use a pirated 
copy. It really is excellent value. Your Free Trial last 15 days. 

Installing Freeframes 
Freeframes are Open Source, cross-platform, standardised plug-ins that work in a variety of host systems 
including Resolume, ArKaos, VJamm, Grid Pro, Wax, Jitter, Isadora, Sony Vegas, Adobe Premiere, After 
Effects, and Director. The standard  was first developed by VJs (including the developers of Resolume)  primarily 
for VJ use, although the usefulness and adaptability of Freeframes mean that they©re quickly spreading well 
beyond the VJ Community. 

There are many different Freeframe Filters. Some are, as the name suggests, free. Others cost money - we call 
those Payframes ;) Video examples of many Freeframes can be seen on the web at Freeframe.org  

Because Freeframes are developed by individual developers, there isn't a standardised way to install them. 
Most of them come with instructions, either on their parent website or in a readme.txt or similarly named file that 
should have come with the Freeframe file.  

Some come as a set in an executable file .exe – these just need to be double-clicked and have a built-in 
Windows installer. Eg: 

Veejay pack 1.1 from http://freeframe.visualvinyl.net/ comes with a handy wizard: 
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Ditto with FFPPbasic by the same guy: 

   

   

Summary of Process: 
This is what we’ll be doing: 

A) Videoing something 

B) Capturing the video to your computer/hard-drive, using a Firewire Cable and Video Capture Software 
Exsate DV Capture (you could also use Premiere, Windows Movie Maker, Final Cut Pro etc)                     

aka “Ripping the video”:            

C) Editing the captured footage into VJ-formatted clips using VirtualDub (although again, you could do 
this in Premiere, Windows Movie Maker or Final Cut Pro IF THE CODECS WORK PROPERLY – test a 
clip in Resolume before doing a million clips!) 

D) Loading the clips into Resolume, creating decks, applying effects etc. 

E) Recording your VJ’d output back to mini-DV, either using your camera (if it has video-in) or our mini-
DV desk and “Second Screen” with overscan to record full-screen video.  

OR  



13 Copyright Kat Black + Jasper Cook, 2006. � � � � � � � � � �

Capturing using Exsate DV Capture  
To transfer your footage to your PC, first ensure that you have the Panasonic DV codec installed. Then: 

1. Plug in your camera using Firewire, S-video or USB as appropriate for your camera. Set your camera 
to “VCR” mode. Make sure it’s turned on. Hopefully your computer will detect and install it, if this is the 
first time you©ve plugged it into your computer. Rewind your tape. 

2. Open Exsate DV Capture. Select a drive and folder where you©ll have enough room for the ripped 
video files - remember, they©re BIG (about 12 Gig per hour of footage for DV). Name the file something 
useful and descriptive. 

 

 

If you have the Hard-drive space, you might want to just capture the whole tape while you go and make 
yourself a coffee. Or you can be fussy and just capture the bits you want manually - that©s what I©ll do here.  

3. Select the “I am going to capture manually” option. 

4. Select DV AVI Type 2 for the output file format. 

  

We won©t stuff around making the exact VJ clips yet - we©ll be doing that in Virtual Dub later. Just grab 
reasonably long slabs of footage that you want to harvest from.  
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5. The program now gives you some reassuring details of what you©re about to do. Just follow the prompts. 

 

Then, the main capture interface appears, which is lovely and simple apart from one glaring design fault, that the 
Capture and Play buttons are exactly the same! Yes, they©re both a Green Arrow, the universal Play symbol. I©ve 
cheated a bit here to show you the mouse-over titles for both of them. Now, why couldn©t they have made that 
Manual Capture (ie, Record) button a Red Circle, like every other interface?? Ah well, I guess I©ll get over it. 

 

You can collect a few clips in this way. It will even tell you how much room you have left on your Hard-drive. 
When you’ve finished, click Next and you’re done. 

  

 



15 Copyright Kat Black + Jasper Cook, 2006. � � � � � � � � � �

Editing clips using Virtual Dub 1.6  
Virtual Dub is a Freeware Video Editing Program. It©s fairly basic and you can only deal with one layer of video, 
but it©s great for cutting up, resizing and fixing up .avi files. 

1. Open Virtual Dub 1.6.15. OK, so it’s not very friendly looking, but you’ll soon learn to love it… 

 

Before you open a video file, it’s VERY important to select appropriate settings. It©s a bit of a process, but we’ll 
Save Settings to use again – then you can File>Load Settings next time and skip to Step 8. 

2. Click Video > Filters > Add to get a list of available Filters. 

�  

 

Although Virtual Dub doesn’t support Freeframe Effects, it does have its own development community making 
extra filters. This is where you can load (install) new Filters, and they will appear in this list as you install them. 
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3. First, apply the Deinterlacing filter. This converts interlaced footage (for example from your video 
camera), in which each alternate field only contains half of the image information, into progressive 
footage, where each frame contains the full image. In VJing, we often change the speed and direction of 
the clip, so it’s important to get as much information as possible into every frame. If your footage is 
already deinterlaced, doing it again may lose image detail – so don’t. The order in which you apply 
Filters can be very important, and this is one of those times. Deinterlace must go before Resize, or 
else you’ll end up exaggerating the interlacing rather than removing it. 

  
4. Second, Resize the image to your chosen Vjing size. As discussed previously, we’re currently using 

400x300, but you may choose to use 640x480 or full PAL (720x576). There are a variety of algorithms 
you can choose from to resize. For now, choose bilinear, but you can do some tests and choose 
something else if you prefer.  

  
5. After the filters, adjust your audio settings to specify no audio – this will make the file smaller. Resolume 

can’t play audio anyway.  
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Now, let’s deal with Compression. As per the earlier discussion of Codecs, we currently use Ligos Indeo 5.2. It 
costs US$15 though, so you could use the free Indeo 5.1 which is also a good Vjing codec. 

6. Click Video > Compression and choose Indeo 5.1 or Ligos Indeo 5.2. Specify the following settings: 

��Maximum quality (100) 

��Datarate of 2000 kb/sec which runs well with our setup – you may need to tinker to suit yours. 

��Keyframe every frame to get the maximum image information per frame.  

7. Click the Configure button and specify these settings: 

��Scalability.  

��No Transparency (Alpha Channels), as sadly, it’s not supported in Resolume. Leave the others as-is. 

  
8. Now, you need to actually open a typical video file that you’ll be editing from to adjust the remaining 

settings. For example, a long .avi ripped from your video camera that you want to cut up into clips. 
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Cropping may be required, depending on your camera – you can see here the edges of a fish-eye lens 
showing.  

9. Open the Resize Filter that you’ve already added and click the Cropping button. In the preview window 
that’s now popped up, drag the edges of the frame in until you’re happy with the visible area. You can 
drag the playhead along to check that it’s fine all through the clip, then click “OK”. 

  
10. Depending on your camera, you may need to adjust the Levels.  

a. Click Video>Filter>Add>Levels.  

b. Click Sample Frame then drag the Input levels to look right, using the Histogram and Preview 
Popup. You can drag the playhead to check it’s fine all through the clip. You can also “Sample 
Frame” to get the Histogram again at any point – although the Levels Filter will apply the same 
settings to the whole clip.  

c. When you have settings that you’d be happy with for the whole clip, click OK. 

  

 
11. And now you’ve done all this work, File>Save Processing Settings to use again next time! Pick some 

sensible name ;) 

  

You can use this Settings File as a basis for others too by opening it, making the changes you want (for example 
to suit footage from a different camera) and then saving it as a different name. 

12. Now, to actually make your clips! First we set the In and Out points. 

Unlike many expensive video editing packages, you can easily click through frame by frame to accurately set 
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your In and Out points. There are several ways to do this: 

·  Buttons: Mark-In and Mark-Out at the bottom 
·  Menu: Edit>Set Selection Start and Set Selection End 
·  Keyboard: the Home (to set In) and End (to set Out) keys.  

 

Here you can see my chosen area highlighted blue in the timeline. 

 

13. Then, save your selected segment as an .avi using the menu: File>Save as AVI or use the keyboard F7 
key. 

  
 

14. You can continue, harvesting multiple clips from the same file. Save each clip as soon as you have 
marked them in/out - you cannot mark in/mark out multiple sections and save each clip in a batch. Name 
them something sensible and put them into your VJ Folder structure, in a place you can easily find 
them again. For example, R:\Resolume\VJclips.  

Resolume references files where they are located, so if you go renaming or moving files around, it©ll end up in 
tears. For this reason, we keep our harvesting and captured files in a completely different place to our VJ Folder 
structure, and ONLY correctly formatted VJ-ready files go into our VJ Folder, where they sit undisturbed, just to 
be used by Resolume - we©re careful not to move or rename them. If you’re going to be using an external drive, 
make sure to move them all there before you open them in Resolume, don’t reference them on your C: drive if 
you’re intending to be moving them, you’ll end up with dead decks. If you’re working on a laptop and intend 
actually VJing, you’ll completely clog up your laptop’s hard-drive in no time, so we suggest getting yourself an 
external drive for clips. We take about a Terrabyte (1000 Gig) of data to gigs with us – which of course means 
large, powered External Hard-drives. Just for today, it will be OK to save them on your laptop drive, eg 
C:\Program Files\Resolume 2.3\VJclips but remember that this may fill up your hard-drive, and any decks you 
make today will need the clips to stay there to work. Can you spare the space? 

You can make as many clips as you have time for - but 20 clips would be a good number to aim for today, as 
that©s one full deck in Resolume.  
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Editing From DVD 
DVDs may have copyright protection on them, and for this reason developers and distributors of DVD Decrypting 
Programs are often pursued legally and prevented from sharing their programs. 

As previously mentioned, we do not advocate piracy and we encourage you as fellow creatives to respect the 
copyright of others. We do not, however, believe that a format such as DVD should be able to be restricted – in 
particular by companies who do not own copyright of the creative content.  

There are various programs that can be used to Decrypt DVDs into .vob format files. Look them up on the web 
for yourself, now you know what you’re looking for. 

But then, once you’re at that stage – what next? What can you edit a .vob in anyway? 

An older version of Virtual Dub (v1.5) can open .vob files ripped from DVD - although there are audio-sync 
issues. As you may wish to edit .vob files without audio, we©ve included that old version on the CD. We find it 
handy for editing video harvested from Public Domain DVD movies.  

You can have two different versions of Virtual Dub – I name the shortcuts appropriately on my Desktop: 
VirtualDub1.5 for DVD and VirtualDub1.6 for DVcap 
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Setting your Second Screen for Output 
When you plug a projector or other output into your computer, there are two options on how your computer©s 
main screen and the other output screen relate to each other. They can either be identical - known as Mirroring 
- or they can be different - known as Second Screen. 

With VJing, we need your settings to be for Second Screen, as you©ll have your VJ interface (Resolume controls)  
on your main monitor and the treated output video stream on the other (eg the Projector). Something like this: 

Laptop Screen - Resolume controls “Second Screen” Projector, TV etc 
 

How you achieve these settings will vary depending on your graphics card and drivers. This is just one 
example, chances are your options for settings will look completely different. We©ll help you to set your screen 
appropriately and make sure you know how to change it back again. For example, if you use your lappie for 
doing Powerpoint presentations, this is NOT how you want your settings to be, as Powerpoint mimics this in 
Mirroring mode. 

An EXAMPLE of setting your Second Screen for video-out with s-Video or AV-Out (but NOT monitor-out, for 
which you may need a Scan Converter). Unfortunately, Firewire does NOT work as video-out for Screens. 

Automatic: 

Make sure you have something plugged into your video-out and turned on (eg video desk, projector or TV). If 
you boot your computer up like this, it©s quite likely Windows XP will auto-detect it. If you plug in the video desk 
or whatever to your S-video port AFTER turning on the computer, the Second Screen shows as Inactive (greyed 
out). 

Setting your Second Screen Manually: YES, YOURS WILL BE DIFFERENT! 

1. Right-click on your desktop, select Properties and click on the Settings tab. 

2. Click the inactive number 2 screen icon, and click Apply. Your screen may go blank for a few seconds as 
Windows tries to work out what©s attached. 

3. Change the screen resolution for the second screen to 800 x 600. Notice this is much lower than my 
laptop©s screen. 800x600 is fairly typical for a projector, and higher than PAL resolution. Considering that 
the clips we©re working with are only 400x300, to try to push the second screen to cope with any higher 
resolution than 800x600 would just strain my computer©s processing power for no gain in output quality. 

4. Go for the highest Colour Quality you can choose as an option. 

5. Click OK. 

  



22 Copyright Kat Black + Jasper Cook, 2006. � � � � � � � � � �

If you have a decent graphics card, select Overscan if you©re outputting to record or project. Basically, 
Overscan enlarges the image slightly to fill the whole projected area - which if you were watching on a TV 
would mean that you©d miss some of the image. You may be familiar with the concept of “Safe Area” in video 
editing, which is what will show on a cruddy TV in worst-case scenario – this is sort of the reverse of that – we 
want to expand out right to the edges of the largest possible visible area, to avoid black edge-lines. 

In the case of my Radeon ATI Mobility 9600 card, these are the options and what I have set. Make sure the 
settings are right for your country/device. In this case, Australian standard PAL B. 

   

   
If your Graphics Card doesn©t support Overscan and the black lines around the edges of your projection bothers 
you, then you can use a piece of hardware called a Scan Converter on your Monitor-out (VGA) port. You may 
also need to do this if you don©t HAVE video-out. A Scan Converter takes a Monitor-out signal and converts it to 
a Video signal (S-video and/or AV signal).  

IMPORTANT: You need to have your Second Screen settings correct before you boot up Resolume, as 
Resolume will detect the Output based on Windows current settings. If you open Resolume without your Second 
Screen activated, it will forget your previous settings and you©ll have to shut Resolume down, activate your 
second screen, boot-up Resolume again and set Resolume©s settings again. A major pain in the bum, so please 
remember to turn on your Second Screen BEFORE booting up Resolume. 
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Introduction to Resolume 2.3 
Resolume is both simple, and yet very complex. You can be up and running, doing cool things with your video 
within ten minutes. And yet, it can take years to really master it and to develop your own style. Even then, new 
Freeframes are coming out all the time, so your style can be constantly evolving along with the technology. One 
thing I can promise you, you©ll never get bored or reach the limit of possibilities with Resolume. 

With scores of effects, three layers of video, many blending methods between the layers and a range of 
parameters within many of the effects, there are millions of potential combinations of effects - all of which you 
can apply real-time. 

That©s why we©re calling this a mere introduction to Resolume. Unfortunately, there is no comprehensive manual 
as it©s so new, so rapidly evolving and includes so many third-party Freeframe Plug-Ins. The greatest pleasure in 
using Resolume though is developing complex combinations of your own, “recipes” we like to call them, so we 
don©t want to be too proscriptive. Besides, VJzoo have our own distinctive style and we©d rather your work didn©t 
resemble our own too closely! 

Getting Started in Resolume 
As we’ve mentioned several times now, make sure your Second Screen is set in Windows before opening 
Resolume. Now, open Resolume. Here are the basics of the layout, which may vary depending on your Screen 
Resolution. 

 

·  Global Effect Layers – up to 3 Effects, which you drag from the Browser>Effects section 

·  Browser – Files, to find Clips on your hard-drives to drag into a Deck; Decks, which are saved sets of 
20 tweaked Clips; Sources – to set direct inputs such as Live Cameras; Effects – to choose Freeframes 
and inbuilt Effects to apply to Clips or Globally; Audio – where you can adjust the settings for audio-
triggering throughout the program. 

·  Output Window – can also be set to show a four-way split of each Layer plus the Output.  

·  Clip – this is where you drag your video to and tweak frame-rate, direction, effects etc to save as part of 
a Deck;  

·  Deck – a set of 20 tweaked Clips saved to be reloaded from the Browser Decks tab when required. 
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Changing Resolume’s Interface Font 
If, like us, you find Resolume©s interface font hard to read, the only way to change it is to delete the Feisar fonts 
from your system altogether. A pity, as it©s funky title font, but it©s not very easy to read when so small - 
especially if you©re dyslexic and you have a screen resolution of 1920x1200 pixels.  

To delete the fonts in Windows, go to Settings> Control Panel> Fonts> Feisar.ttf and delete. Ditto Feisar Bold. 

 

With Feisar font, as installed by Resolume 

Without Feisar font - reverts to Arial in interface 

 

Screen Setup in Resolume 
The setting you choose in Screen Setup will depend on the size you’ve chosen to make your Clips (Process 
Resolution) and the resolution your Second Screen is set to in Windows (Output Resolution). If your computer 
can cope, choose 32 bit color. On Screen 1 we choose Preview, and on Screen 2, Fullscreen. Click Apply when 
you’ve made your adjustments. Your screen may flicker a bit – just wait for it to settle down. 
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If you turned on Resolume without having your Second 
Screen active in Windows, you’ll get something like 
this instead.  

You have to close down Resolume, set your Second 
Screen in Windows, restart Resolume and then redo 
your Screen Setup in Resolume. What a pain.  

Don’t you wish you’d remembered to check your 
Second Screen before starting Resolume? 

 

 

Resolume Decks 
A Deck is a collection of up to 20 Clips that you can save to load later. You can have up to 8 Decks loaded at a 
time, which you navigate using the tabs at the bottom. In each Deck, all the properties and effects you apply to 
your Clips are saved. Decks are therefore really handy to prepare your show beforehand. 

First of all, you©ll need to place some Files (from the Browser tab on the top left) into an empty Deck. When 
you©ve placed your Clip in a Deck, you can click on it and it will play in the Active Layer. 

To place a Clip in a Deck:  

1. In Resolume, click the Sources tab and open up your clips folder until you see your avi files. This will 
open the last place you looked (as long as you have that drive plugged in and turned on). 

2. Drag a Clip to an empty spot on the deck. If you want to put more Clips into the Deck at once, you can 
highlight up to 20 avi files and drag the lot onto the deck. 

3. Save your Deck using the Save As tab at the bottom of the Deck. If you make any changes to your 
deck, you can save the changes by clicking the save deck button in the right top corner above the deck. 

4. The Decks tab automatically opens and a new item is created. You can immediately type in a name for 
your new deck. 

All the deck files are saved on the hard-drive in C:\Program Files\Resolume 2.3\Decks. You can find all your 
created decks in the Decks tab in the Browser. 

Loading a Deck 
To load a deck from the list; select one item and drag it to one of the eight tabs at the bottom of the deck.  

To load multiple decks you can either double click a deck’s category or you can select multiple items in the 
decks list and drag those to the deck tabs below the grid of channels. 

Deck Sections 
A Section is category within the Decks Tab – sort of like a Folder. When you save a Deck, it will automatically 
save in the last Section, but you can move it to something that makes more sense to you. If, like us, you intend 
accumulating a lot of content, you will want to create New Sections with logical category names. 

1. Close any Decks you have open (or Resolume may get a little confused and hide the deck in some 
random category). 

2. Right-click on the Decks tab and select New Section. 

3. Type in the name of your new category. 

You can see here all of the categories we use. Unfortunately you can©t have sub-categories, and every time you 
open Resolume, all the categories are open - which is a pain when you have hundreds of decks to scroll down 
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through to choose the category you want until you minimise the Sections. 

Active Layer 
To play a Clip, click on it in the Deck and it will play in the Active Layer (the one with the pink border around it).. 
Resolume can overlay up to three clips in sections called layers. If you’ve done any photoshopping, you’ll 
probably get the hang of layers pretty quickly.  

Before you start experimenting with multiple layers though, we’ll have a closer look at some basic controls and 
how to use them to manipulate the Clip in the Active Layer. Please just stick to using one Layer until you’re 
confident with everything else though. 

 

On the left side at the top are Layer Close, Make Inactive, Move Up and Move Down.  

Below that, we see familiar Play Controls: Backwards, Forward, Pause and Random. Random is best used 
with a slow frame rate, which is controlled on the far right as a mouse-controlled slider. Random jumps the play-
head around and makes your video seem like flashing stills - with a lot less effort than shooting hundreds of still 
photos. 

To the right of that, we have Loop - which means the clip keeps repeating itself from beginning to end; Bounce - 
which means the clip plays beginning to end in one direction, then plays backwards back to the beginning and so 
on; Play Once means the clip plays through and then freezes on the last frame as a still.  

Above that, you can set where to start the clip each time you select it from the Deck to put in the Active Layer. 

At the top are the RGB channels. We’ll cover those in more detail later. 

Below that are the Layer Transition Effects, which we©ll come back to when we cover Layers. Some of your 
Freeframe Effect Plug-Ins are applied here. 

The slider on the left of the Clip window determines the amount of Layer Transition Effect - the default being 
Alpha/Opacity.  

On the far right is Frame Rate, ie Clip Speed. Underneath is the Playhead position - although you can only see 
it moving when you have your mouse over the Layer. 

Wherever you see the speaker symbol, that means the control can be audio-triggered. We©ll cover this later too. 

Effects 
This is where it starts to be fun. Effects change how your clip looks. You can apply an effect to a single clip so 
that it affects that clip only (Local Effect) or you can apply an affect to the Output after the three layers of video 
have been blended together (Global effect). 

To apply a Local Effect: 

1. Click the Effects tab of the Browser to show the list of available effects. This list shows all the built-in 
effects and also some of the Freeframe Effect plugins you’ve installed.  

2. Drag an effect to a Clip in the Deck. Now, when you play the clip, it will apply that Effect. If you save the 
deck again, it will remember to keep that Effect on that Clip in that Deck. 

To turn an effect OFF when it©s been applied to a clip in a deck, right-click on the clip to open it up, then click the 
cross in the bottom right-hand corner – or apply the same Effect again to turn it off (uh huh….). 

If you©ve tweaked settings in a way that you want to use again, you can make the settings you©ve adjusted the 
default for that effect by clicking the little Disk icon in the corner of the effect. Then, next time you use that 
Effect either as a Local or Global, it will apply with those settings. 
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In the screenshot below, I’ve applied the Chromium Local Effect to a Clip by dragging the Effect down to the 
Clip in the Deck. 

 

Now, that looks pretty gross and would white-out a room if you were projecting. So let©s add another effect to the 
mix. Remember, you can only apply ONE effect to a Clip (Local Effect), but you can also apply up to three 
Global Effects. That is, Effects that apply to everything that©s currently playing. OK, “everything” at this stage is 
just the one clip, but as we start to add more layers, you©ll see what I mean.  

To apply a Global Effect: 

1. Click the Effects tab in the Browser to show the list of available Effects.  

2. Drag an Effect to one of the three panels on the left.  

In this example, I©ve applied “Invert” (ie, negative). Our output, shown in the top right window, looks marginally 
less disgusting. 

 

To turn off a Global Effect, click the red cross in the top corner, or drag the same effect again to that Global 
Effect Layer. Alternatively, you can click the “Inactive square” to make the effect inactive but left in place ready to 
quickly turn on again. You’ll probably find this very handy. You can also find Inactive Squares on the Layers. 

 

 

 

Inactive square 
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Effects apply cumulatively, and the order in which they©re applied makes a difference. You can change the 
order of application of the global effects by using the up and down arrow next to the Inactive square. Local 
Effects are always applied first. 

Adjusting an Effect 
Some effects have possible adjustments. Every effect is different and it©s fun dragging around the sliders to see 
what happens.  

You can see all the parameters of the Global Effects easily, but to access the parameters of a Local Effect 
you’ve applied to a Clip, Right-click on the Clip in the deck. A window pops up showing you all the parameters 
you can adjust for that effect. You close it the same way, by Right-clicking on the Clip. You can remove the 
Effect by clicking the X in the corner, or by dragging the same Effect to the same place (go figure!) 

If you save the deck, it will save all of the Effect parameters as they currently are set on that clip.  

Hmm, that dull drive-by clip is starting to look a bit more interesting and it©s only taken a couple of clicks :) 

 

The adjustments possible for an Effect are the same whether it’s being applied as a Local or Global Effect. If you 
like your fine-tuning so much that you want that to be the new Default for when that Effect’s applied, click the 
little Disk icon in the corner. 

One of the effects I used here is Delay RGB, which brings me to a fundamental of how Resolume works. The 
Red, Green and Blue Channels can be easily split (as in the Delay RGB Effect) or turned on/off individually. This 
is also a good effect to show how motion in the clip can influence the effect - note the colour-trails. 
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At this stage, you©re ready to start playing and getting used to the effects and other controls. We©d suggest 
spending some time experimenting just with the one layer of video, so you can see what©s going on as you apply 
different effects and adjust the parameters of each effect. 

Here are a few examples - note the different parameter adjustments possible for each. Notice also that as well 
as using the sliders to adjust the parameters, you can adjust them to move with the playhead (eg cycling through 
colours), to move with the mouse, or to move with audio. 

   
Layer up the Global Effects to find combinations you like. Use the up and down arrows to change the order in 
which the effects are applied - it will make quite a difference with some effects. 

 

This will keep you amused for ages. If we had more time, we©d send you off to play for a week at this point and 
forbid you from using layers just yet to ensure that you really explored the effects, what they do and how they 
suit different clips. But, we only have a weekend, so let©s soldier on. 
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Relationships between Layers  
You can have up to three layers of video in Resolume. We often only use one layer, unless we©re layering with 
clips we©ve specifically made for layering - such as this high-contrast clip of a dancer in a black dress against a 
white background. 

 

As you can see, the default of the layers is Alpha Opacity, set to 50%.You can alter this with the slider to the left 
of the layer that©s “on top”. If you©ve used layers in Photoshop or any other similar program, you©ll know it©s like 
stacking sheets on top of each other. If you add another layer, it covers over the one underneath. 

 

 

 

 

Apart from the straightforward Alpha, there are other ways the layer can interact with the one below it. Here are 
some basic ones built into Resolume:  

·  Inverse Luma Key - White disappears first 
·  Luma Key - Black disappears first 

 

  
I won©t show Alpha Transparency here, as with these clips it looks exactly the same as Alpha. 

As well as the options that are clearly named buttons, such as Darken (a little less clunky than Inverse Luma 
Key) you can also right-click on some of the buttons to access additional Transition Effects.  

Some Freeframe Effects are actually applied in Layers rather than from the Effects section in the Browser. As 
with the other effects, half the fun is working out what does what, so we won©t give too many examples here. 
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You may have noticed that you can©t use the same instance of a clip from a deck as multiple layers. If you want 
to layer a clip on top of itself, simply have multiple instances of the clip in a deck. That©s also a good way to save 
pleasing versions of tweaked effects, as you can always right-click on that tweaked version and then save it as 
the default for that effect to use it again on another clip. Don©t try just replacing the clip in the deck though, as the 
effect you©d applied and tweaked will disappear with the old clip. 

Now, let©s put all that together. See if you can work out what©s going on here. 

 

The bottom layer is my drive-by clip. I©ve applied Chromium effect on that clip (ie, Local Effect). I made some 
adjustments to the parameters by right-clicking on the clip in the deck. 

Then in the layer above, I have my dancer clip. Even though the contrast was very high, I©ve added Burn as a 
Local Effect so that her arms and legs were a little darker. 

For the relationship between the layers, I chose Darken as it gave me a smoother, cleaner result than the similar 
Inverse Luma Key. I then tweaked the slider until the background blended in and the dancer©s detail could all still 
be seen- about 58% 

The next effect I applied was Wave, as a Global Effect. This Wave is one of the awesome filters by Pete 
Warden, a very generous Freeframe developer who puts a lot of time into developing beautiful filters and then 
gives them away for free. Wave was probably the most significant filter to us in the development of our “Video 
Painting” style. It is very dependent on movement, as it created pulses of alternating positive-negative ghosts of 
an image. Note that the effect value slider (next to the RGB buttons) is pulled quite low. This is one effect where 
a little bit is often enough. Although if you want to get very abstract, trying pushing it to the max and applying it 
multiple times :) 

On top of all of this, I©ve applied the Global Effect Inverse - which has made everything into negative. 
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How can we save these settings? 
Unfortunately, you can©t save a whole configuration like this. While you can save a deck, including the local 
effect and its parameters as currently applied to a particular clip, you can©t save the whole kit-and-caboodle. 

Our solution is to take screenshots - that©s how we©ve made these notes. On a PC, hit the Prnt Scrn button 
(near the top right of your keyboard) and then paste into a new image file in a graphics program (such as 
PhotoShop, PaintShop Pro or Gimp) or even a Word Processor. 

The problem with this is that it©s unwieldy, and probably our greatest obstacle in Live Cinema performances as 
fine tuning settings is very time consuming and difficult to do on the fly.  

You can specify particular decks to load on startup, and you can save your favourite settings as the 
default on an effect, but none of that©s much help when you©re trying to change between one complete setup 
and another between tracks with a sit-down audience watching! We do our best to get around it by playing tag 
and taking turns - one of us sets up the next track while the other performs, then we mix across and the other 
person sets up for the next track. Certainly flicking between screenshots and Resolume isn©t ideal in such 
circumstances, so we©re looking forward to the day when Resolume has the ability to save full configurations and 
easily load them with only a few seconds offline. 

Don't Do This While We're Watching... 
As mentioned previously, we’re not big fans of cheesy effects and WinAmp VJing. But in case you ever agree to 
do a Benefit Gig in a forest to a bunch of stoners: 

Audio Triggering 
This may seem obvious, but you©re going to need audio in your computer to do this. And preferably a built-in 
microphone. The music needs to be loud too, if it©s not actually coming from your computer. 

Before we start though, I should warn you. Unless you have some really simple doof-doof bassline drowning out 
everything else, music is NOT very good to audio-trigger with - it©s too complex. It©s a lot easier to APPEAR to 
have something music-synced by simply tweaking the frame-rate until it LOOKS in time to the music. 

Let©s hope you really want to use this to trigger a video installation to react to footsteps in a quiet gallery space, 
or something along those lines - that will be more likely to produce a satisfying cause/effect relationship. 

Try to limit the number of bands for each audio-trigger. In this case, I©ve used a clip of food-colouring dripped in a 
jar of water, and applied the Kaleidescope effect. The audio trigger is Low (Bass frequencies) and the parameter 
that I©ve applied the trigger to is Output Angle. Not that you can tell from a screenshot, but this was rotating in 
time to some music. Well, sort of. I tried tweaking but honestly, it looked more in time with the music when I just 
had all the parameters moving to the Playhead. If you want it to look like WinAmp, I suggest using WinAmp ;) 
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Extra Things You Might Want to Know 
Although we’re not going to have time to cover any of these things in our weekend workshop, they’re covered 
pretty well in Resolume’s online manual at resolume.com but we’ll demonstrate them briefly in the course so you 
can see if you’re interested in pursuing the particular functions after the workshop. 

Using Stills 
You can use stills in Resolume - .jpg and .psd files. These need to be resized to a consistent size. It’s a toss 
up… do you make them as small as your videos and lose the quality… do you let Resolume resize them, which 
may slow down it’s processing power, or do you use them separately from your video files and bother to alter 
your settings to suit?  

We have our stills at 800x600, even though our videos and thus our Processing Settings are usually 400x300. If 
we’re using a lot of stills, we might change our Processing Settings to 800x600 for a session, but if we’re missing 
stills and video, we just keep the 400x300 setting and use the 800x600 stills as they are. They still look OK, and 
they’re flashing so fast… who’s going to notice if they’re not terribly sharp? 

Chaos Mode 
Resolume has a built-in “Autopilot”. Handy for toilet breaks - although people might think you©re dispensable ;)  

Direct Camera Input 
We rarely put a camera feed directly into Resolume, although we often play with video feedback through our VJ 
Desk, in conjunction with Resolume. We’ll demonstrate that at the workshop.  

We have tried out a variety of cameras as direct Resolume input and found we got better results with a small, 
firewire iBot webcam rather than bigger video cameras. This might also be a driver issue.  

Video Feedback 
See tutorial at Resolume site: www.resolume.com/support/manual-2-2/tutorial-feedback.html 

Using Midi Devices with Resolume 

Don©t boys just love to twiddle knobs? 

Midi allows you to trigger just about any of the functions of Resolume with an external hardware device. There 
are a huge range of midi devices. Some are made for VJing, but most of them (especially the less expensive 
ones) are actually audio tools that have been adapted or commandeered for use by VJs. 

We use a Mixman DM2 and eVolution U-Control UC-16 and UC-33 Midi Controllers. 

The DM2 is great fun for scratching, and has quite a few nice big buttons and sliders. It’s a kid’s toy and one of 
the cheapest devices you can get for external triggering. It’s a lot of fun, and ours have withstood a couple of 
years of pretty hefty use. A DM2 doesn’t technically trigger in midi, but there’s a third party driver that converts 
it’s own signal into midi, and thus makes it usable as a midi device in VJ software. 

We use the UC-16 to control the parameters of Freeframe Effects in Resolume, particularly for our Video 
Painting work which relies a lot of sensitive and subtle manipulation of the effects. 

As you continue playing with VJing tools, you’ll probably have a hundred questions. Please feel free to email us. 
We’re usually pretty helpful �  
 

Thanks for all your time and hard work! 
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 Please list three things that you found useful about the course: 
 

1. 
 

2. 
 

3. 
 
Can you suggest any improvements to the course? (use back of this sheet for additional 
comments if required) 
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This evaluation will be used to assess and a    d  Lecturers: 
improve the quality of the course. Your g    i Kat Black + Jasper 
response to each question and any suggestions r    s Date: July 2006 

you consider useful will be appreciated. 
 

e    a Course: Paint ing With Light  
     Please mark your response in the box for each e    g Fremantle 
     question. If not applicable please leave blank. 
1= Strongly Agree; 2= Agree Somewhat; 3= Indifferent;  
4= Disagree Somewhat; 5=Strongly Disagree 

1 2 3 4 5 Your Comments 

       
       

Course Structure, Content & Organisation 
1. The topics covered were relevant to your       
work/future       
2. The Workbook was well organised       

Outcomes of the Course 
3. You are now more confident about the subject       
4. You will be able to apply the skills and       
knowledge you have learned       
Lecturer's Style 
5. The lecturer was well prepared       

6. Topics were presented clearly       

7. The lecturer was enthusiastic       
8. There was positive interaction and feedback       
between you and the lecturer.       
Module Presentation 
9. The objectives and the assessment criteria were       
made clear to you at the outset.       
10. The notes and handouts were well presented.       
11. The training aids/equipment were suitable for       
this course. (or what you needed to bring was clear)       
12. The venue was appropriate for this course.       
13. Access to relevant reference material was       
appropriate.       


